
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

3051 Bug report Rejected Low Allowing 'geometryless' tables in PostGIS datasource is showing system tables/schemas Jürgen 

Fischer

2011-12-17 01:41 AM

3051 Bug report Rejected Low Allowing 'geometryless' tables in PostGIS datasource is showing system tables/schemas Jürgen 

Fischer

2011-12-17 01:41 AM

3814 Bug report Rejected Low Polygonize generates a custom projection instead of using the source projection Giuseppe 

Sucameli

2011-09-01 03:18 AM

3814 Bug report Rejected Low Polygonize generates a custom projection instead of using the source projection Giuseppe 

Sucameli

2011-09-01 03:18 AM

3968 Bug report Rejected Normal MailingList : qgis-commit seem to be no more refresh with last commits. 2012-04-17 08:58 AM

3968 Bug report Rejected Normal MailingList : qgis-commit seem to be no more refresh with last commits. 2012-04-17 08:58 AM

4027 Bug report Rejected Normal Icon missing in the menu when using ubuntu since 2009 2011-07-29 01:23 AM

4027 Bug report Rejected Normal Icon missing in the menu when using ubuntu since 2009 2011-07-29 01:23 AM

4065 Bug report Rejected Normal PostGIS connection from PGAdmin - troublesome on win7? 2011-07-10 12:43 AM

4065 Bug report Rejected Normal PostGIS connection from PGAdmin - troublesome on win7? 2011-07-10 12:43 AM

4118 Bug report Rejected Normal QGIS 1.8 uses gdal 1.6 instead of gdal 1.8 under ubuntu 2011-08-29 10:06 PM

4118 Bug report Rejected Normal QGIS 1.8 uses gdal 1.6 instead of gdal 1.8 under ubuntu 2011-08-29 10:06 PM

4120 Bug report Rejected Normal cannot use the plugin installer when installed using osgeo4w setup 2011-08-01 01:02 AM

4120 Bug report Rejected Normal cannot use the plugin installer when installed using osgeo4w setup 2011-08-01 01:02 AM

4161 Bug report Rejected Normal Adding WMS layers through file browser: nothing displayed at first Martin Dobias 2011-08-12 09:42 PM

4161 Bug report Rejected Normal Adding WMS layers through file browser: nothing displayed at first Martin Dobias 2011-08-12 09:42 PM

4181 Bug report Rejected Normal Cannot select labels with various tools Marco 

Hugentobler

2011-08-18 04:52 AM

4181 Bug report Rejected Normal Cannot select labels with various tools Marco 

Hugentobler

2011-08-18 04:52 AM

4209 Bug report Rejected Normal Fail when using clipper from Gdal Tools 2011-08-23 12:37 AM

4209 Bug report Rejected Normal Fail when using clipper from Gdal Tools 2011-08-23 12:37 AM

4215 Bug report Rejected Normal Abfragen auf Layer aufheben 2011-11-01 03:31 AM

4215 Bug report Rejected Normal Abfragen auf Layer aufheben 2011-11-01 03:31 AM

4292 Bug report Rejected Normal How is it possible.... 2011-09-16 03:10 AM

4292 Bug report Rejected Normal How is it possible.... 2011-09-16 03:10 AM

4845 Bug report Rejected Normal Hardcoded Encodings Maxim 

Dubinin

2012-02-21 12:52 AM

4845 Bug report Rejected Normal Hardcoded Encodings Maxim 

Dubinin

2012-02-21 12:52 AM

5102 Bug report Rejected Normal query ["field" != 'NULL'] works while ["field" = 'NULL'] doesn't 2012-03-30 02:48 AM

5102 Bug report Rejected Normal query ["field" != 'NULL'] works while ["field" = 'NULL'] doesn't 2012-03-30 02:48 AM

5168 Bug report Rejected Normal Grass plugin is disappeared 2012-03-12 12:34 PM

5168 Bug report Rejected Normal Grass plugin is disappeared 2012-03-12 12:34 PM

5184 Bug report Rejected Low GoogleLayersPlugin 0.7.2 crash with 1.74 and QGIS-master 2012-05-23 06:15 AM

5184 Bug report Rejected Low GoogleLayersPlugin 0.7.2 crash with 1.74 and QGIS-master 2012-05-23 06:15 AM

5207 Bug report Rejected High Error handling null values (numeric, decimal) Jürgen 

Fischer

2012-03-20 03:20 AM

5207 Bug report Rejected High Error handling null values (numeric, decimal) Jürgen 

Fischer

2012-03-20 03:20 AM

5304 Bug report Rejected Normal Google layers plugin won't load 2012-04-04 09:25 AM

5304 Bug report Rejected Normal Google layers plugin won't load 2012-04-04 09:25 AM

5413 Bug report Rejected High Virus in grass-6.4.2 package, QGIS 1.7.4 2012-04-19 03:12 AM

5413 Bug report Rejected High Virus in grass-6.4.2 package, QGIS 1.7.4 2012-04-19 03:12 AM

5564 Bug report Rejected Normal linux qgis nightly-build built using 2-years-old gdal 1.7.3, creating misaligned on-the-fly reprojected layers 2012-05-16 09:15 AM

5564 Bug report Rejected Normal linux qgis nightly-build built using 2-years-old gdal 1.7.3, creating misaligned on-the-fly reprojected layers 2012-05-16 09:15 AM

5863 Bug report Rejected Severe/Regression QGIS doesn't start 2012-06-25 09:21 AM

5863 Bug report Rejected Severe/Regression QGIS doesn't start 2012-06-25 09:21 AM

5900 Bug report Rejected High QGIS 1.8.0 windows standalone ships with GDAL version that causes new attribute data loss in Shapefiles 2012-06-30 04:36 AM

5900 Bug report Rejected High QGIS 1.8.0 windows standalone ships with GDAL version that causes new attribute data loss in Shapefiles 2012-06-30 04:36 AM

6261 Bug report Rejected Normal Trusted connected 2012-08-27 11:31 PM

6261 Bug report Rejected Normal Trusted connected 2012-08-27 11:31 PM

6298 Bug report Rejected Normal Gdal Tools and OSX Mountain Lion (OSX 10.8.1) 2012-09-03 02:13 AM

6298 Bug report Rejected Normal Gdal Tools and OSX Mountain Lion (OSX 10.8.1) 2012-09-03 02:13 AM

6334 Bug report Rejected Normal print composer - add a tsblr 2012-09-11 11:34 PM

6334 Bug report Rejected Normal print composer - add a tsblr 2012-09-11 11:34 PM

6380 Bug report Rejected Normal Primary Key with multiple columns are not 2012-09-20 01:38 PM

6380 Bug report Rejected Normal Primary Key with multiple columns are not 2012-09-20 01:38 PM

6387 Bug report Rejected Normal MSSQL tables - Primary Key with multiple columns Problem Tamas 

Szekeres

2012-09-21 06:47 AM

6387 Bug report Rejected Normal MSSQL tables - Primary Key with multiple columns Problem Tamas 

Szekeres

2012-09-21 06:47 AM

6623 Bug report Rejected Normal Sorting of columns wrong 2012-11-05 03:43 AM

6623 Bug report Rejected Normal Sorting of columns wrong 2012-11-05 03:43 AM

6636 Bug report Rejected Normal Latest gdal update leads to crash with mrsid-layer 2012-11-06 03:38 AM

6636 Bug report Rejected Normal Latest gdal update leads to crash with mrsid-layer 2012-11-06 03:38 AM

6851 Bug report Rejected Normal QGIS Master displays error message when a raster is loaded 2012-12-11 03:41 AM

6851 Bug report Rejected Normal QGIS Master displays error message when a raster is loaded 2012-12-11 03:41 AM

6936 Bug report Rejected Normal GRASS plugin missing from qgis 1.8/osgeo4w 2013-01-03 12:23 PM

6936 Bug report Rejected Normal GRASS plugin missing from qgis 1.8/osgeo4w 2013-01-03 12:23 PM

7047 Bug report Rejected Normal Python support broken/disabled on QGIS' quantal master builds when running on ubuntu's upcoming ringtail 13.04 2013-01-25 03:40 AM

7047 Bug report Rejected Normal Python support broken/disabled on QGIS' quantal master builds when running on ubuntu's upcoming ringtail 13.04 2013-01-25 03:40 AM

7059 Bug report Rejected Normal From EPSG3003 to EPSG4326 matter 2013-01-28 03:14 AM

7059 Bug report Rejected Normal From EPSG3003 to EPSG4326 matter 2013-01-28 03:14 AM

7088 Bug report Rejected Normal Polygonizer plug-in not working in Master 2013-03-11 04:09 AM

7088 Bug report Rejected Normal Polygonizer plug-in not working in Master 2013-03-11 04:09 AM

7106 Bug report Rejected Normal Error when running python functions / plugins 2013-02-06 07:34 AM

7106 Bug report Rejected Normal Error when running python functions / plugins 2013-02-06 07:34 AM

7158 Bug report Rejected Normal Virus in the current version 1.8.0-2 2013-02-15 02:20 AM
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7158 Bug report Rejected Normal Virus in the current version 1.8.0-2 2013-02-15 02:20 AM

7326 Bug report Rejected Normal GeoCoding Plugin 2013-03-11 11:48 PM

7326 Bug report Rejected Normal GeoCoding Plugin 2013-03-11 11:48 PM

7334 Bug report Rejected Normal GeoCoding Plugin 2013-03-12 06:22 AM

7334 Bug report Rejected Normal GeoCoding Plugin 2013-03-12 06:22 AM

7559 Bug report Rejected Normal mmqgis join fail 2013-04-09 10:16 PM

7559 Bug report Rejected Normal mmqgis join fail 2013-04-09 10:16 PM

7980 Bug report Rejected Normal "Merge connected lines..." doesn't work well Larry Shaffer 2013-06-03 11:14 AM

7980 Bug report Rejected Normal "Merge connected lines..." doesn't work well Larry Shaffer 2013-06-03 11:14 AM

8162 Bug report Rejected Normal QGIS master error matplotlib 2013-06-26 04:29 AM

8162 Bug report Rejected Normal QGIS master error matplotlib 2013-06-26 04:29 AM

8272 Bug report Rejected Normal Bad size request with a georeferenced raster 2019-01-29 01:56 PM

8272 Bug report Rejected Normal Bad size request with a georeferenced raster 2019-01-29 01:56 PM

8684 Bug report Rejected Normal searching for help and documentation in the QGIS site - search tool bug (any lowercase and uppercase distinction) ? 2013-09-26 06:10 AM

8684 Bug report Rejected Normal searching for help and documentation in the QGIS site - search tool bug (any lowercase and uppercase distinction) ? 2013-09-26 06:10 AM

8789 Bug report Rejected Normal QGIS failing to load semi automatic classification plugin and otb and saga not configured 2013-10-07 11:49 AM

8789 Bug report Rejected Normal QGIS failing to load semi automatic classification plugin and otb and saga not configured 2013-10-07 11:49 AM

8815 Bug report Rejected Low QGIS Visual Studio 2012 build - runtime fail 2013-10-10 09:09 AM

8815 Bug report Rejected Low QGIS Visual Studio 2012 build - runtime fail 2013-10-10 09:09 AM

8915 Bug report Rejected Normal Newline character of Python output is forced to LF only 2014-03-24 09:01 AM

8915 Bug report Rejected Normal Newline character of Python output is forced to LF only 2014-03-24 09:01 AM

8980 Bug report Rejected Normal svg fill issue: lines not rendered correctly 2014-05-19 07:52 AM

8980 Bug report Rejected Normal svg fill issue: lines not rendered correctly 2014-05-19 07:52 AM

9036 Bug report Rejected Normal db manager's spatialite node gone in latest qgis master 2014-01-23 11:31 PM

9036 Bug report Rejected Normal db manager's spatialite node gone in latest qgis master 2014-01-23 11:31 PM

9056 Bug report Rejected Normal QGIS Userlist Mailinglist reject my reply 2013-11-12 02:06 PM

9056 Bug report Rejected Normal QGIS Userlist Mailinglist reject my reply 2013-11-12 02:06 PM

9267 Bug report Rejected Normal Plus button for Default datum transformations doesn't work 2014-01-18 02:09 AM

9267 Bug report Rejected Normal Plus button for Default datum transformations doesn't work 2014-01-18 02:09 AM

9773 Bug report Rejected Low Issue with Memory Provider example code in PyQGIS Cookbook 2015-03-05 05:40 AM

9773 Bug report Rejected Low Issue with Memory Provider example code in PyQGIS Cookbook 2015-03-05 05:40 AM

9860 Bug report Rejected Normal openlayers plugin crashes qgis master 2014-03-24 01:53 PM

9860 Bug report Rejected Normal openlayers plugin crashes qgis master 2014-03-24 01:53 PM

9891 Bug report Rejected High QGIS hub has bad performance 2014-03-27 10:57 AM

9891 Bug report Rejected High QGIS hub has bad performance 2014-03-27 10:57 AM

9997 Bug report Rejected Normal Commit changes to database creates invalid geometry 2014-10-02 09:39 AM

9997 Bug report Rejected Normal Commit changes to database creates invalid geometry 2014-10-02 09:39 AM

10049 Bug report Rejected Normal toc: point symbols not visible if in map units 2014-04-15 06:56 AM

10049 Bug report Rejected Normal toc: point symbols not visible if in map units 2014-04-15 06:56 AM

10105 Bug report Rejected Normal How to sent coordinates in the right projection to PostGIS 2014-06-21 02:36 AM

10105 Bug report Rejected Normal How to sent coordinates in the right projection to PostGIS 2014-06-21 02:36 AM

10134 Bug report Rejected Normal Credential Dialog, disabling default Realm information messages that discloses password Jürgen 

Fischer

2014-04-30 03:26 AM

10134 Bug report Rejected Normal Credential Dialog, disabling default Realm information messages that discloses password Jürgen 

Fischer

2014-04-30 03:26 AM

10139 Bug report Rejected Normal Saving queries option missing? 2016-05-24 10:53 PM

10139 Bug report Rejected Normal Saving queries option missing? 2016-05-24 10:53 PM

10259 Bug report Rejected Normal processing - Model text doesn't honor Model GUI Victor Olaya 2015-06-07 04:31 AM

10259 Bug report Rejected Normal processing - Model text doesn't honor Model GUI Victor Olaya 2015-06-07 04:31 AM

10416 Bug report Rejected Normal Spatialite provider: QGIS doesn't compile with new SL 4.2.0 Sandro 

Furieri

2014-06-02 01:02 PM

10416 Bug report Rejected Normal Spatialite provider: QGIS doesn't compile with new SL 4.2.0 Sandro 

Furieri

2014-06-02 01:02 PM

10577 Bug report Rejected Normal WFS data provaider crashes when "Cache Feature" is activated 2014-06-13 06:51 AM

10577 Bug report Rejected Normal WFS data provaider crashes when "Cache Feature" is activated 2014-06-13 06:51 AM

10897 Bug report Rejected Normal Openlayer plugin not appearing when reinstalled in 2.4. Borys Jurgiel 2014-07-15 11:44 PM

10897 Bug report Rejected Normal Openlayer plugin not appearing when reinstalled in 2.4. Borys Jurgiel 2014-07-15 11:44 PM

11083 Bug report Rejected Normal Error QSphere plugin started 2014-08-20 11:18 PM

11083 Bug report Rejected Normal Error QSphere plugin started 2014-08-20 11:18 PM

11108 Bug report Rejected Normal Semi-Automatic Classification Plugin error 2014-08-27 09:31 AM

11108 Bug report Rejected Normal Semi-Automatic Classification Plugin error 2014-08-27 09:31 AM

11170 Bug report Rejected Normal Export to OpenLayers3 not working 2017-10-16 02:39 PM

11170 Bug report Rejected Normal Export to OpenLayers3 not working 2017-10-16 02:39 PM

11171 Bug report Rejected Normal OpenLayers3 plugin not loading basemap in firefox- google chrome works fine 2014-10-04 12:59 AM

11171 Bug report Rejected Normal OpenLayers3 plugin not loading basemap in firefox- google chrome works fine 2014-10-04 12:59 AM

11172 Bug report Rejected Normal Export to OpenLayers3 crash Qgis when Label uses Field Expression 2014-09-15 06:25 AM

11172 Bug report Rejected Normal Export to OpenLayers3 crash Qgis when Label uses Field Expression 2014-09-15 06:25 AM

11173 Bug report Rejected Normal OpenLayers3 not showing nothing when Style is Rule-Based 2014-10-04 12:59 AM

11173 Bug report Rejected Normal OpenLayers3 not showing nothing when Style is Rule-Based 2014-10-04 12:59 AM

11174 Bug report Rejected Normal Qgis processing toolbox is breaking encoding of output shapefile 2015-06-07 04:33 AM

11174 Bug report Rejected Normal Qgis processing toolbox is breaking encoding of output shapefile 2015-06-07 04:33 AM

11204 Bug report Rejected Normal License issue - removal of MIT/X copyright notice from code sourced from another project. Alexander 

Bruy

2015-06-07 04:31 AM

11204 Bug report Rejected Normal License issue - removal of MIT/X copyright notice from code sourced from another project. Alexander 

Bruy

2015-06-07 04:31 AM

11268 Bug report Rejected Normal Error when importing matplotlib 1.4 2014-09-25 09:47 AM

11268 Bug report Rejected Normal Error when importing matplotlib 1.4 2014-09-25 09:47 AM

11314 Bug report Rejected Normal gdal-python 1.11.1-1 2014-10-05 01:37 AM

11314 Bug report Rejected Normal gdal-python 1.11.1-1 2014-10-05 01:37 AM

11495 Bug report Rejected Normal it is not possible to select the extent of another layer in the Modeler Victor Olaya 2015-05-20 01:21 AM

11495 Bug report Rejected Normal it is not possible to select the extent of another layer in the Modeler Victor Olaya 2015-05-20 01:21 AM

11666 Bug report Rejected Normal Processing graphical modeler can't open previously saved .model files. Victor Olaya 2015-04-10 05:39 AM

11666 Bug report Rejected Normal Processing graphical modeler can't open previously saved .model files. Victor Olaya 2015-04-10 05:39 AM

11707 Bug report Rejected Normal OpenLayer Plugin QGIS 2.6 Brighton 2014-11-21 01:59 AM

11707 Bug report Rejected Normal OpenLayer Plugin QGIS 2.6 Brighton 2014-11-21 01:59 AM

12015 Bug report Rejected Normal Allow transfer of rasters from QGIS to PostGIS through DBManager 2015-01-20 08:27 AM
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12015 Bug report Rejected Normal Allow transfer of rasters from QGIS to PostGIS through DBManager 2015-01-20 08:27 AM

12314 Bug report Rejected Normal QGIS crashes when creating a raster layer histogramm 2015-04-10 05:34 AM

12314 Bug report Rejected Normal QGIS crashes when creating a raster layer histogramm 2015-04-10 05:34 AM

12582 Bug report Rejected Normal buildvrt causes QGIS to crash 2017-01-24 03:01 AM

12582 Bug report Rejected Normal buildvrt causes QGIS to crash 2017-01-24 03:01 AM

13080 Bug report Rejected High QT Forms. Opening two forms using IdentifyFeatures crashes 2017-03-08 06:36 AM

13080 Bug report Rejected High QT Forms. Opening two forms using IdentifyFeatures crashes 2017-03-08 06:36 AM

13252 Bug report Rejected Normal windows 8 2015-08-22 05:33 AM

13252 Bug report Rejected Normal windows 8 2015-08-22 05:33 AM

13365 Bug report Rejected Low QGIS CRS works only when the planets aligns 2015-09-16 02:43 PM

13365 Bug report Rejected Low QGIS CRS works only when the planets aligns 2015-09-16 02:43 PM

13563 Bug report Rejected Normal Processing: R plots are too small Victor Olaya 2017-05-03 07:35 PM

13563 Bug report Rejected Normal Processing: R plots are too small Victor Olaya 2017-05-03 07:35 PM

13936 Bug report Rejected Normal R script and data type qlonglong the output was always empty Victor Olaya 2017-05-03 07:37 PM

13936 Bug report Rejected Normal R script and data type qlonglong the output was always empty Victor Olaya 2017-05-03 07:37 PM

14086 Bug report Rejected Normal gdal tools - proximity (non-ascii characters) 2016-01-13 09:23 AM

14086 Bug report Rejected Normal gdal tools - proximity (non-ascii characters) 2016-01-13 09:23 AM

14150 Bug report Rejected Normal tuple index out of range when trying to launch Command: load from commander 2016-05-26 05:50 AM

14150 Bug report Rejected Normal tuple index out of range when trying to launch Command: load from commander 2016-05-26 05:50 AM

14338 Bug report Rejected Normal Generated shapefile from custom application is not always displayed in QGIS 2017-09-22 10:05 AM

14338 Bug report Rejected Normal Generated shapefile from custom application is not always displayed in QGIS 2017-09-22 10:05 AM

14403 Bug report Rejected Normal Processing toolbox was not updated on 2.14 release as mentioned 2017-09-22 10:05 AM

14403 Bug report Rejected Normal Processing toolbox was not updated on 2.14 release as mentioned 2017-09-22 10:05 AM

14466 Bug report Rejected Low Conditional formatted table cells expressions are evaluated wrong Nathan 

Woodrow

2018-10-15 03:58 AM

14466 Bug report Rejected Low Conditional formatted table cells expressions are evaluated wrong Nathan 

Woodrow

2018-10-15 03:58 AM

14483 Bug report Rejected Low Processing documentation for QGIS 2.14 is outdated/missing 2016-03-14 04:55 AM

14483 Bug report Rejected Low Processing documentation for QGIS 2.14 is outdated/missing 2016-03-14 04:55 AM

14579 Bug report Rejected Normal Weird OGR Error using MMQGIS to geocode 2017-09-22 10:05 AM

14579 Bug report Rejected Normal Weird OGR Error using MMQGIS to geocode 2017-09-22 10:05 AM

14606 Bug report Rejected High Overlay tools and join Attributes from the processing are work correctly 2017-09-22 10:05 AM

14606 Bug report Rejected High Overlay tools and join Attributes from the processing are work correctly 2017-09-22 10:05 AM

14645 Bug report Rejected Normal "select by expression” algorithm in modeler Victor Olaya 2016-04-18 09:11 AM

14645 Bug report Rejected Normal "select by expression” algorithm in modeler Victor Olaya 2016-04-18 09:11 AM

14650 Bug report Rejected Normal Processing > Import Vector into PostGIS database > error 2016-04-10 08:16 AM

14650 Bug report Rejected Normal Processing > Import Vector into PostGIS database > error 2016-04-10 08:16 AM

14656 Bug report Rejected Normal ImportError: No module named PyQt 2016-04-11 10:11 PM

14656 Bug report Rejected Normal ImportError: No module named PyQt 2016-04-11 10:11 PM

14669 Bug report Rejected Normal Processing: Kriging rscripts/Kriging_with_model_selection.rsx problem with solution Victor Olaya 2017-05-01 11:06 AM

14669 Bug report Rejected Normal Processing: Kriging rscripts/Kriging_with_model_selection.rsx problem with solution Victor Olaya 2017-05-01 11:06 AM

14681 Bug report Rejected Normal WFS Layer - Static Character Encoding 2016-10-06 01:27 PM

14681 Bug report Rejected Normal WFS Layer - Static Character Encoding 2016-10-06 01:27 PM

14735 Bug report Rejected Normal SagaAlgorithm since Saga 2.2.4: RESAMPLING instead of INTERPOL 2017-09-22 10:05 AM

14735 Bug report Rejected Normal SagaAlgorithm since Saga 2.2.4: RESAMPLING instead of INTERPOL 2017-09-22 10:05 AM

14937 Bug report Rejected Low Expose "Featured" plugins in plugin manager Borys Jurgiel 2016-06-01 02:47 AM

14937 Bug report Rejected Low Expose "Featured" plugins in plugin manager Borys Jurgiel 2016-06-01 02:47 AM

14948 Bug report Rejected Normal Processing creategrid Victor Olaya 2016-06-10 01:07 AM

14948 Bug report Rejected Normal Processing creategrid Victor Olaya 2016-06-10 01:07 AM

14993 Bug report Rejected Normal Processing not compatible with QGIS 2.8 or 2.10 Victor Olaya 2016-06-10 03:32 AM

14993 Bug report Rejected Normal Processing not compatible with QGIS 2.8 or 2.10 Victor Olaya 2016-06-10 03:32 AM

15018 Bug report Rejected High closing a docked attribute window crashes QGIS 2017-09-22 10:05 AM

15018 Bug report Rejected High closing a docked attribute window crashes QGIS 2017-09-22 10:05 AM

15121 Bug report Rejected Normal Join Attributes by Location doesn't process integer attributes Victor Olaya 2016-06-24 12:08 AM

15121 Bug report Rejected Normal Join Attributes by Location doesn't process integer attributes Victor Olaya 2016-06-24 12:08 AM

15191 Bug report Rejected Low When cancel "script opening", occurs an error 2016-07-08 01:15 AM

15191 Bug report Rejected Low When cancel "script opening", occurs an error 2016-07-08 01:15 AM

15207 Bug report Rejected Normal Print layout: remove empty groups 2017-09-22 09:55 AM

15207 Bug report Rejected Normal Print layout: remove empty groups 2017-09-22 09:55 AM

15361 Bug report Rejected Normal WFS can't add multilinestring 2016-10-06 01:10 PM

15361 Bug report Rejected Normal WFS can't add multilinestring 2016-10-06 01:10 PM

15366 Bug report Rejected Severe/Regression Attribute table sorts numeric values like text 2016-08-01 05:55 AM

15366 Bug report Rejected Severe/Regression Attribute table sorts numeric values like text 2016-08-01 05:55 AM

15480 Bug report Rejected Normal processing modeler: 'run model' and 'edit model help' does not work Victor Olaya 2016-08-23 05:04 AM

15480 Bug report Rejected Normal processing modeler: 'run model' and 'edit model help' does not work Victor Olaya 2016-08-23 05:04 AM

15564 Bug report Rejected Normal Change default value in Vector | Research Tools | Grid | Parameters 2016-09-15 01:15 AM

15564 Bug report Rejected Normal Change default value in Vector | Research Tools | Grid | Parameters 2016-09-15 01:15 AM

15579 Bug report Rejected Normal Copy & Paste Issue Attibute table 2017-05-13 10:19 AM

15579 Bug report Rejected Normal Copy & Paste Issue Attibute table 2017-05-13 10:19 AM

15585 Bug report Rejected Normal Where can I find binaries of current stable version for OS X? 2017-09-22 09:55 AM

15585 Bug report Rejected Normal Where can I find binaries of current stable version for OS X? 2017-09-22 09:55 AM

15654 Bug report Rejected Normal Processing: TrainImagesClassifier (libvm) returns an error message Victor Olaya 2017-05-03 07:18 PM

15654 Bug report Rejected Normal Processing: TrainImagesClassifier (libvm) returns an error message Victor Olaya 2017-05-03 07:18 PM

15712 Bug report Rejected Normal Dissolve function crash QGIS 2.16.3 2017-09-22 09:55 AM

15712 Bug report Rejected Normal Dissolve function crash QGIS 2.16.3 2017-09-22 09:55 AM

15761 Bug report Rejected Low Please provide a Toolbox interface to SAGA 3 2017-09-22 09:55 AM

15761 Bug report Rejected Low Please provide a Toolbox interface to SAGA 3 2017-09-22 09:55 AM

16069 Bug report Rejected Normal Random extract Processing test fails 2017-04-27 04:28 AM

16069 Bug report Rejected Normal Random extract Processing test fails 2017-04-27 04:28 AM

16126 Bug report Rejected Normal Processing: Tools for LiDAR data 2017-05-03 07:28 PM

16126 Bug report Rejected Normal Processing: Tools for LiDAR data 2017-05-03 07:28 PM

16158 Bug report Rejected Normal Generic Help system: Remove the margin within the frame 2017-09-22 09:54 AM

16158 Bug report Rejected Normal Generic Help system: Remove the margin within the frame 2017-09-22 09:54 AM

16211 Bug report Rejected Normal Random Extract within Subsets saving only one subset Victor Olaya 2017-05-03 02:59 PM

16211 Bug report Rejected Normal Random Extract within Subsets saving only one subset Victor Olaya 2017-05-03 02:59 PM

16397 Bug report Rejected High "hidden" edit widget does not work on QGIS 2.18 (and master) Matthias Kuhn 2017-05-12 03:55 PM
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16397 Bug report Rejected High "hidden" edit widget does not work on QGIS 2.18 (and master) Matthias Kuhn 2017-05-12 03:55 PM

16410 Bug report Rejected Normal Clear cache button doesn't work 2017-09-22 09:53 AM

16410 Bug report Rejected Normal Clear cache button doesn't work 2017-09-22 09:53 AM

16442 Bug report Rejected Normal NavigationToolbar2Qt symbols missing? 2017-04-19 06:10 AM

16442 Bug report Rejected Normal NavigationToolbar2Qt symbols missing? 2017-04-19 06:10 AM

16519 Bug report Rejected High Processing: error when to trying to reproject layer Victor Olaya 2017-05-05 09:52 AM

16519 Bug report Rejected High Processing: error when to trying to reproject layer Victor Olaya 2017-05-05 09:52 AM

16558 Bug report Rejected Normal ImportError: cannot import name NavigationToolbar2QTAgg Alexander 

Bruy

2017-05-16 06:27 PM

16558 Bug report Rejected Normal ImportError: cannot import name NavigationToolbar2QTAgg Alexander 

Bruy

2017-05-16 06:27 PM

16627 Bug report Rejected Normal problems add delimited text layer Alvaro Huarte 2017-05-26 06:31 PM

16627 Bug report Rejected Normal problems add delimited text layer Alvaro Huarte 2017-05-26 06:31 PM

16723 Bug report Rejected High Create grid (polygon) has no parameters Victor Olaya 2017-08-28 08:43 AM

16723 Bug report Rejected High Create grid (polygon) has no parameters Victor Olaya 2017-08-28 08:43 AM

16772 Bug report Rejected Normal check validity algorithm with GEOS method does not detect ring self-intersection 2017-07-01 11:01 AM

16772 Bug report Rejected Normal check validity algorithm with GEOS method does not detect ring self-intersection 2017-07-01 11:01 AM

16797 Bug report Rejected Normal Overwriting GeoJOSN file is confirmed only via dialog "OK" 2017-07-06 06:26 AM

16797 Bug report Rejected Normal Overwriting GeoJOSN file is confirmed only via dialog "OK" 2017-07-06 06:26 AM

17017 Bug report Rejected Normal QgsDataSourceURI missing from qgis.core Denis 

Rouzaud

2017-11-11 01:16 PM

17017 Bug report Rejected Normal QgsDataSourceURI missing from qgis.core Denis 

Rouzaud

2017-11-11 01:16 PM

17436 Bug report Rejected Normal Menus appear in wrong place 2017-11-10 01:25 AM

17436 Bug report Rejected Normal Menus appear in wrong place 2017-11-10 01:25 AM

17492 Bug report Rejected High QGIS master: action names do not show 2018-01-15 05:43 AM

17492 Bug report Rejected High QGIS master: action names do not show 2018-01-15 05:43 AM

17546 Bug report Rejected Normal Couldn't load plugin 'processing' due to an error when calling its classFactory() method 2017-11-25 09:00 PM

17546 Bug report Rejected Normal Couldn't load plugin 'processing' due to an error when calling its classFactory() method 2017-11-25 09:00 PM

17820 Bug report Rejected High [Processing] Union algorithm does not pick attributes from the other layer Victor Olaya 2018-01-15 08:20 AM

17820 Bug report Rejected High [Processing] Union algorithm does not pick attributes from the other layer Victor Olaya 2018-01-15 08:20 AM

17825 Bug report Rejected Normal File browser broken with gtk backend 2019-02-05 10:08 PM

17825 Bug report Rejected Normal File browser broken with gtk backend 2019-02-05 10:08 PM

17830 Bug report Rejected Normal Qgis 2.18.15 absolute paths in file 2018-01-09 10:06 PM

17830 Bug report Rejected Normal Qgis 2.18.15 absolute paths in file 2018-01-09 10:06 PM

17831 Bug report Rejected Normal Reopen #17824 2018-01-09 11:42 PM

17831 Bug report Rejected Normal Reopen #17824 2018-01-09 11:42 PM

18006 Bug report Rejected Normal Geoprocessing Tools Fail with Memory Layers in QGIS 2.18 2018-02-01 06:37 PM

18006 Bug report Rejected Normal Geoprocessing Tools Fail with Memory Layers in QGIS 2.18 2018-02-01 06:37 PM

18212 Bug report Rejected Normal Voronoi creates overlapping polygons Victor Olaya 2018-02-26 08:48 AM

18212 Bug report Rejected Normal Voronoi creates overlapping polygons Victor Olaya 2018-02-26 08:48 AM

18242 Bug report Rejected Normal Process modeler UI elements not expanding to fill containers Victor Olaya 2018-02-27 08:17 AM

18242 Bug report Rejected Normal Process modeler UI elements not expanding to fill containers Victor Olaya 2018-02-27 08:17 AM

18393 Bug report Rejected High GRASS plugin is not available from debian repository if GRASS 7.4 is installed 2018-03-09 12:54 AM

18393 Bug report Rejected High GRASS plugin is not available from debian repository if GRASS 7.4 is installed 2018-03-09 12:54 AM

18448 Bug report Rejected High Raster Calculator 2018-03-15 02:20 PM

18448 Bug report Rejected High Raster Calculator 2018-03-15 02:20 PM

18511 Bug report Rejected High QGIS 3.0 Ajouter une couche vecteur selon protocole Geojson - Ne fonctionne plus Gilles 

LACROIX

2018-04-04 11:03 AM

18511 Bug report Rejected High QGIS 3.0 Ajouter une couche vecteur selon protocole Geojson - Ne fonctionne plus Gilles 

LACROIX

2018-04-04 11:03 AM

18531 Bug report Rejected High pp.main fails 2018-04-05 11:46 AM

18531 Bug report Rejected High pp.main fails 2018-04-05 11:46 AM

18587 Bug report Rejected Normal Problem adding ArcGIS MapServer with proxy url Sandro Mani 2018-04-08 10:27 PM

18587 Bug report Rejected Normal Problem adding ArcGIS MapServer with proxy url Sandro Mani 2018-04-08 10:27 PM

18618 Bug report Rejected Normal Herramienta de nodos y Añadir objeto 2018-04-04 10:55 AM

18618 Bug report Rejected Normal Herramienta de nodos y Añadir objeto 2018-04-04 10:55 AM

18657 Bug report Rejected Normal error after used SCP plugin 2018-05-06 12:57 PM

18657 Bug report Rejected Normal error after used SCP plugin 2018-05-06 12:57 PM

18680 Bug report Rejected Normal [Processing]"Contains" and "Does not contain" operators do no work with not string fields 2018-05-06 03:09 PM

18680 Bug report Rejected Normal [Processing]"Contains" and "Does not contain" operators do no work with not string fields 2018-05-06 03:09 PM

18747 Bug report Rejected Low QGIS Server GetPrint issue on Desktop Linux installations 2018-07-23 10:19 AM

18747 Bug report Rejected Low QGIS Server GetPrint issue on Desktop Linux installations 2018-07-23 10:19 AM

18756 Bug report Rejected Normal crash opening a map with UTF-8 character type 2018-04-18 09:18 PM

18756 Bug report Rejected Normal crash opening a map with UTF-8 character type 2018-04-18 09:18 PM

18762 Bug report Rejected Normal Raster > Conversion > Rasterize error Paul Day 2018-04-25 10:26 AM

18762 Bug report Rejected Normal Raster > Conversion > Rasterize error Paul Day 2018-04-25 10:26 AM

18798 Bug report Rejected High Polygon Shapefile loaded as Multipolygon 2018-10-11 03:29 PM

18798 Bug report Rejected High Polygon Shapefile loaded as Multipolygon 2018-10-11 03:29 PM

18993 Bug report Rejected Normal QGIS3 Layout: the html label renderer ignores many styles e.g. font-size, letter-spacing, line-height, text-indent, 

margin.

2018-10-15 07:23 AM

18993 Bug report Rejected Normal QGIS3 Layout: the html label renderer ignores many styles e.g. font-size, letter-spacing, line-height, text-indent, 

margin.

2018-10-15 07:23 AM

19197 Bug report Rejected Normal Crash when activating Digitizing Tools 2018-06-15 12:07 PM

19197 Bug report Rejected Normal Crash when activating Digitizing Tools 2018-06-15 12:07 PM

19201 Bug report Rejected Normal Authentification in QGIS doesn't ask master password - security breach Alessandro 

Pasotti

2018-09-05 03:23 PM

19201 Bug report Rejected Normal Authentification in QGIS doesn't ask master password - security breach Alessandro 

Pasotti

2018-09-05 03:23 PM

19288 Bug report Rejected Normal GDAL compression parameters 2018-06-29 12:11 PM

19288 Bug report Rejected Normal GDAL compression parameters 2018-06-29 12:11 PM

19416 Bug report Rejected Normal Bad layers crash 2018-07-20 08:00 AM

19416 Bug report Rejected Normal Bad layers crash 2018-07-20 08:00 AM

19420 Bug report Rejected High Toolbox Processing panel disappear 2018-07-16 12:14 AM

19420 Bug report Rejected High Toolbox Processing panel disappear 2018-07-16 12:14 AM

19425 Bug report Rejected Normal QGIS 3.2. ERROR[38] UNABLE TO LOAD RASTER 2018-07-17 01:50 AM
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19425 Bug report Rejected Normal QGIS 3.2. ERROR[38] UNABLE TO LOAD RASTER 2018-07-17 01:50 AM

19453 Bug report Rejected Normal Crash in 3.2.0 when rendering map 2018-07-21 02:59 AM

19453 Bug report Rejected Normal Crash in 3.2.0 when rendering map 2018-07-21 02:59 AM

19476 Bug report Rejected Normal "PyCapsule_GetPointer called with incorrect name" when trying to build master 2018-08-04 12:11 PM

19476 Bug report Rejected Normal "PyCapsule_GetPointer called with incorrect name" when trying to build master 2018-08-04 12:11 PM

19488 Bug report Rejected High Opening an Existing qgis file 2018-07-25 10:12 PM

19488 Bug report Rejected High Opening an Existing qgis file 2018-07-25 10:12 PM

19515 Bug report Rejected Normal QGIS Rapidly Uses RAM on Fedora 28 When Adding Layer 2018-08-01 04:43 AM

19515 Bug report Rejected Normal QGIS Rapidly Uses RAM on Fedora 28 When Adding Layer 2018-08-01 04:43 AM

19580 Bug report Rejected Normal Undocked panel shifting (sometimes...) 2018-08-10 03:45 PM

19580 Bug report Rejected Normal Undocked panel shifting (sometimes...) 2018-08-10 03:45 PM

19581 Bug report Rejected Normal Docked panel height changed on next startup 2018-08-10 01:53 AM

19581 Bug report Rejected Normal Docked panel height changed on next startup 2018-08-10 01:53 AM

19603 Bug report Rejected Normal Plugin contour : The plugin will be disabled because it crashed QGIS during last startup. Please report an issue and 

re-enable the plugin when the problem has been solved.

Borys Jurgiel 2018-08-13 07:01 AM

19603 Bug report Rejected Normal Plugin contour : The plugin will be disabled because it crashed QGIS during last startup. Please report an issue and 

re-enable the plugin when the problem has been solved.

Borys Jurgiel 2018-08-13 07:01 AM

19620 Bug report Rejected Normal Couldn't load plugin QuickOSM due to an error when calling its classFactory() method Borys Jurgiel 2018-08-14 04:42 AM

19620 Bug report Rejected Normal Couldn't load plugin QuickOSM due to an error when calling its classFactory() method Borys Jurgiel 2018-08-14 04:42 AM

19710 Bug report Rejected Normal QGIS 3.2.2 crash with plugin "Profile Tool 4.1.2" 2018-08-28 12:47 AM

19710 Bug report Rejected Normal QGIS 3.2.2 crash with plugin "Profile Tool 4.1.2" 2018-08-28 12:47 AM

19797 Bug report Rejected Normal Bug in executing clip with polygon from another layer for Digitizing Toolbar 2018-09-11 03:23 PM

19797 Bug report Rejected Normal Bug in executing clip with polygon from another layer for Digitizing Toolbar 2018-09-11 03:23 PM

19921 Bug report Rejected Normal SpatiaLite Execute SQL not working  Nyall Dawson 2018-09-24 08:20 PM

19921 Bug report Rejected Normal SpatiaLite Execute SQL not working  Nyall Dawson 2018-09-24 08:20 PM

19931 Bug report Rejected High The "iterate over this layer" button is missing for the "Extract selected features" algorithm input layer Nyall Dawson 2018-10-01 07:10 AM

19931 Bug report Rejected High The "iterate over this layer" button is missing for the "Extract selected features" algorithm input layer Nyall Dawson 2018-10-01 07:10 AM

19941 Bug report Rejected Normal QgsLineString unexpected behaviour when constructed 2018-09-25 07:01 PM

19941 Bug report Rejected Normal QgsLineString unexpected behaviour when constructed 2018-09-25 07:01 PM

19944 Bug report Rejected Normal Error message when switching UI Theme to night mapping 2018-09-26 11:25 PM

19944 Bug report Rejected Normal Error message when switching UI Theme to night mapping 2018-09-26 11:25 PM

19961 Bug report Rejected Normal Crash while QGIS-Start. 2018-09-27 04:03 AM

19961 Bug report Rejected Normal Crash while QGIS-Start. 2018-09-27 04:03 AM

19993 Bug report Rejected Normal QGIS Crashed running Python code obtained form StackExchnge Thomas 

Kibbey

2019-01-07 05:29 PM

19993 Bug report Rejected Normal QGIS Crashed running Python code obtained form StackExchnge Thomas 

Kibbey

2019-01-07 05:29 PM

20044 Bug report Rejected High QGIS crashes while run custom processing algorithm with a selection output 2018-10-08 11:51 AM

20044 Bug report Rejected High QGIS crashes while run custom processing algorithm with a selection output 2018-10-08 11:51 AM

20056 Bug report Rejected Normal Where is Zonal Statistics? 2018-10-09 09:23 AM

20056 Bug report Rejected Normal Where is Zonal Statistics? 2018-10-09 09:23 AM

20097 Bug report Rejected Normal iface.addvectorlayer doesn't work in processing script 2018-10-13 12:56 AM

20097 Bug report Rejected Normal iface.addvectorlayer doesn't work in processing script 2018-10-13 12:56 AM

20124 Bug report Rejected Low [mdal] Refreshing the canvas does not reload the mesh Peter Petrik 2019-05-03 03:27 PM

20124 Bug report Rejected Low [mdal] Refreshing the canvas does not reload the mesh Peter Petrik 2019-05-03 03:27 PM

20269 Bug report Rejected Normal gdal tools corrupted 2019-02-05 10:03 PM

20269 Bug report Rejected Normal gdal tools corrupted 2019-02-05 10:03 PM

20315 Bug report Rejected Normal Mesh layer and projection on-the-fly Peter Petrik 2019-01-25 02:11 PM

20315 Bug report Rejected Normal Mesh layer and projection on-the-fly Peter Petrik 2019-01-25 02:11 PM

20317 Bug report Rejected Normal VDI packaging of QGIS 3.4 not working. 2018-11-04 09:27 PM

20317 Bug report Rejected Normal VDI packaging of QGIS 3.4 not working. 2018-11-04 09:27 PM

20394 Bug report Rejected Normal Label Placement cartographic position priority value validation not allowing correct values 2018-11-07 11:50 AM

20394 Bug report Rejected Normal Label Placement cartographic position priority value validation not allowing correct values 2018-11-07 11:50 AM

20469 Bug report Rejected High Adding WFS layer fails with "unexpected end of file" 2019-02-06 10:39 PM

20469 Bug report Rejected High Adding WFS layer fails with "unexpected end of file" 2019-02-06 10:39 PM

20664 Bug report Rejected High inability to load Google Open Map Layers 2018-11-29 03:41 PM

20664 Bug report Rejected High inability to load Google Open Map Layers 2018-11-29 03:41 PM

20821 Bug report Rejected Normal grass reclass error - inconsitent use of tabs and spaces 2019-01-22 01:31 PM

20821 Bug report Rejected Normal grass reclass error - inconsitent use of tabs and spaces 2019-01-22 01:31 PM

20832 Bug report Rejected Normal EnMAP-box        Interactive Visualization of Vegetation Reflection Models            Flashback 2018-12-18 10:01 AM

20832 Bug report Rejected Normal EnMAP-box        Interactive Visualization of Vegetation Reflection Models            Flashback 2018-12-18 10:01 AM

20867 Bug report Rejected Normal QGIS 3.4.2 - Extension disabled because it caused QGIS to crash 2019-03-09 10:59 PM

20867 Bug report Rejected Normal QGIS 3.4.2 - Extension disabled because it caused QGIS to crash 2019-03-09 10:59 PM

20892 Bug report Rejected High QGIS crashes when I  do  "print (field_name)" 2018-12-31 03:54 PM

20892 Bug report Rejected High QGIS crashes when I  do  "print (field_name)" 2018-12-31 03:54 PM

20924 Bug report Rejected Normal UnicodeDecodeError: 'utf-8' codec can't decode bytes in position 5178-5179: invalid continuation byte 2019-01-05 08:39 PM

20924 Bug report Rejected Normal UnicodeDecodeError: 'utf-8' codec can't decode bytes in position 5178-5179: invalid continuation byte 2019-01-05 08:39 PM

20937 Bug report Rejected Normal QGIS Crash 2019-01-07 08:36 PM

20937 Bug report Rejected Normal QGIS Crash 2019-01-07 08:36 PM

20984 Bug report Rejected Normal Missing method QgsGeometry::fromPoint 2019-01-13 10:54 PM

20984 Bug report Rejected Normal Missing method QgsGeometry::fromPoint 2019-01-13 10:54 PM

20985 Bug report Rejected Normal osgeo4w packing not requiring pip for QGIS? Jürgen 

Fischer

2019-01-14 01:46 PM

20985 Bug report Rejected Normal osgeo4w packing not requiring pip for QGIS? Jürgen 

Fischer

2019-01-14 01:46 PM

20987 Bug report Rejected Normal semi-automatic classification plugin and QGIS 3.4.3 continually return Errors 2019-01-13 11:59 PM

20987 Bug report Rejected Normal semi-automatic classification plugin and QGIS 3.4.3 continually return Errors 2019-01-13 11:59 PM

20990 Bug report Rejected Normal row_number 2019-01-14 12:26 PM

20990 Bug report Rejected Normal row_number 2019-01-14 12:26 PM

20996 Bug report Rejected High QGIS Master does not export from Multilinestring Geometry type and does not recognize Geometry Type Linestring  

saved by QGIS 2

2019-01-15 09:45 AM

20996 Bug report Rejected High QGIS Master does not export from Multilinestring Geometry type and does not recognize Geometry Type Linestring  

saved by QGIS 2

2019-01-15 09:45 AM

21006 Bug report Rejected High Expressions cannot be cleared/removed in attributes form properties 2019-01-27 07:46 PM

21006 Bug report Rejected High Expressions cannot be cleared/removed in attributes form properties 2019-01-27 07:46 PM

21014 Bug report Rejected Normal Drop shadow in draw effects in layer rendering does not maintain colour if background is changed in print layout 2019-01-16 08:48 PM
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21014 Bug report Rejected Normal Drop shadow in draw effects in layer rendering does not maintain colour if background is changed in print layout 2019-01-16 08:48 PM

21024 Bug report Rejected Normal infected windows installer? 2019-01-18 11:11 PM

21024 Bug report Rejected Normal infected windows installer? 2019-01-18 11:11 PM

21052 Bug report Rejected Normal Layer>Save As>Autocad DXF produces DXF that crashes AutoCAD 2019-01-21 07:24 AM

21052 Bug report Rejected Normal Layer>Save As>Autocad DXF produces DXF that crashes AutoCAD 2019-01-21 07:24 AM

21116 Bug report Rejected Normal processing.run and processing.runAndLoadResults give different output 2019-01-29 10:58 AM

21116 Bug report Rejected Normal processing.run and processing.runAndLoadResults give different output 2019-01-29 10:58 AM

21124 Bug report Rejected High QGIS crashes on Fedora 29 Plasma desktop 2019-02-11 12:18 AM

21124 Bug report Rejected High QGIS crashes on Fedora 29 Plasma desktop 2019-02-11 12:18 AM

21161 Bug report Rejected High scipy import in PyQGIS throws traceback 2019-02-04 01:02 PM

21161 Bug report Rejected High scipy import in PyQGIS throws traceback 2019-02-04 01:02 PM

21172 Bug report Rejected Normal GetFeatureInfo not send Geometry when set into project Alessandro 

Pasotti

2019-02-08 08:46 AM

21172 Bug report Rejected Normal GetFeatureInfo not send Geometry when set into project Alessandro 

Pasotti

2019-02-08 08:46 AM

21211 Bug report Rejected Normal Build errors due to "CL_HPP_TARGET_OPENCL_VERSION is not a valid value (100, 110, 120 or 200). It will be set 

to 200"

Alessandro 

Pasotti

2019-03-12 10:11 AM

21211 Bug report Rejected Normal Build errors due to "CL_HPP_TARGET_OPENCL_VERSION is not a valid value (100, 110, 120 or 200). It will be set 

to 200"

Alessandro 

Pasotti

2019-03-12 10:11 AM

21333 Bug report Rejected High QGIS crashing when adding hyperlink into the Attribute Table Nitzan Matan 2019-03-04 06:24 PM

21333 Bug report Rejected High QGIS crashing when adding hyperlink into the Attribute Table Nitzan Matan 2019-03-04 06:24 PM

21374 Bug report Rejected Normal OTB: Large scale meanshift fails Rashad 

Kanavath

2019-02-25 02:41 PM

21374 Bug report Rejected Normal OTB: Large scale meanshift fails Rashad 

Kanavath

2019-02-25 02:41 PM

21380 Bug report Rejected Normal WFS GET requests default to using "hostname:80' in the host header instead of just "hostname" 2019-03-21 04:53 PM

21380 Bug report Rejected Normal WFS GET requests default to using "hostname:80' in the host header instead of just "hostname" 2019-03-21 04:53 PM

21537 Bug report Rejected Normal mesh vectors does not display [0, y] or [x, 0] Peter Petrik 2019-03-20 10:53 AM

21537 Bug report Rejected Normal mesh vectors does not display [0, y] or [x, 0] Peter Petrik 2019-03-20 10:53 AM

21650 Bug report Rejected Normal calculator not returning correct area 2019-03-22 04:31 PM

21650 Bug report Rejected Normal calculator not returning correct area 2019-03-22 04:31 PM

21686 Bug report Rejected Normal SVG Point symbols missing in GetLegendGraphics Responses Alessandro 

Pasotti

2019-04-02 01:24 PM

21686 Bug report Rejected Normal SVG Point symbols missing in GetLegendGraphics Responses Alessandro 

Pasotti

2019-04-02 01:24 PM

21706 Bug report Rejected Normal Split Vector Layer only saving geopackage 2019-05-21 11:49 AM

21706 Bug report Rejected Normal Split Vector Layer only saving geopackage 2019-05-21 11:49 AM

21824 Bug report Rejected Normal value map widget saves description in stead of value to attribute table 2019-04-11 11:27 AM

21824 Bug report Rejected Normal value map widget saves description in stead of value to attribute table 2019-04-11 11:27 AM

21956 Bug report Rejected Normal QgsGradientColorRamp.invert returns None 2019-04-30 05:04 AM

21956 Bug report Rejected Normal QgsGradientColorRamp.invert returns None 2019-04-30 05:04 AM

21973 Bug report Rejected High select on map: selection is not added when using the CTRL key 2019-05-03 08:44 AM

21973 Bug report Rejected High select on map: selection is not added when using the CTRL key 2019-05-03 08:44 AM

22077 Bug report Rejected Normal Priority in labelling not greyed out when data defined settings are enabled Alessandro 

Pasotti

2019-05-21 08:06 AM

22077 Bug report Rejected Normal Priority in labelling not greyed out when data defined settings are enabled Alessandro 

Pasotti

2019-05-21 08:06 AM

22124 Bug report Rejected Normal proj 6 support in 3.6.x ? Nyall Dawson 2019-05-23 08:22 AM

22124 Bug report Rejected Normal proj 6 support in 3.6.x ? Nyall Dawson 2019-05-23 08:22 AM

5199 Feature request Rejected Normal Relative paths for qgis server 2012-03-18 03:40 PM

5199 Feature request Rejected Normal Relative paths for qgis server 2012-03-18 03:40 PM

5466 Feature request Rejected Normal Use CRS parameter for epsg code Victor Olaya 2017-05-03 07:01 PM

5466 Feature request Rejected Normal Use CRS parameter for epsg code Victor Olaya 2017-05-03 07:01 PM

5468 Feature request Rejected Normal Fill tooltips for OTB algorithms Victor Olaya 2017-05-03 07:02 PM

5468 Feature request Rejected Normal Fill tooltips for OTB algorithms Victor Olaya 2017-05-03 07:02 PM

5703 Feature request Rejected Low Implement raster extent and resolution from an existing raster also for OTB Victor Olaya 2017-05-03 07:04 PM

5703 Feature request Rejected Low Implement raster extent and resolution from an existing raster also for OTB Victor Olaya 2017-05-03 07:04 PM

6520 Feature request Rejected Normal INSPIRE support for QGIS Mapserver 2012-10-16 01:07 AM

6520 Feature request Rejected Normal INSPIRE support for QGIS Mapserver 2012-10-16 01:07 AM

6659 Feature request Rejected Normal gdal_rasterize GUI include the "-tr" option 2012-11-07 08:46 PM

6659 Feature request Rejected Normal gdal_rasterize GUI include the "-tr" option 2012-11-07 08:46 PM

7057 Feature request Rejected Normal DB Manager SQL window should remember query string when closing and re-use the string when re-opening SQL 

window

2013-01-28 12:59 AM

7057 Feature request Rejected Normal DB Manager SQL window should remember query string when closing and re-use the string when re-opening SQL 

window

2013-01-28 12:59 AM

7787 Feature request Rejected Normal Add create and connect Spatialite DB into DBManager 2014-03-26 11:47 AM

7787 Feature request Rejected Normal Add create and connect Spatialite DB into DBManager 2014-03-26 11:47 AM

8043 Feature request Rejected Normal Avoid duplicate nodes from "Extract Nodes" 2016-10-05 05:08 AM

8043 Feature request Rejected Normal Avoid duplicate nodes from "Extract Nodes" 2016-10-05 05:08 AM

8686 Feature request Rejected Normal [feature request] Automatic redirections from language code subdirectories URLs ? 2013-09-26 04:59 AM

8686 Feature request Rejected Normal [feature request] Automatic redirections from language code subdirectories URLs ? 2013-09-26 04:59 AM

8909 Feature request Rejected Normal Add "R dependencies" to R scripts Help files Victor Olaya 2017-05-03 07:32 PM

8909 Feature request Rejected Normal Add "R dependencies" to R scripts Help files Victor Olaya 2017-05-03 07:32 PM

9046 Feature request Rejected Normal Edit form widget: better radio button than checkbox 2013-11-12 08:46 AM

9046 Feature request Rejected Normal Edit form widget: better radio button than checkbox 2013-11-12 08:46 AM

9124 Feature request Rejected Normal Heatmap in percentage 2018-02-25 12:26 PM

9124 Feature request Rejected Normal Heatmap in percentage 2018-02-25 12:26 PM

9469 Feature request Rejected Normal Split lines with points layer Victor Olaya 2015-06-07 04:33 AM

9469 Feature request Rejected Normal Split lines with points layer Victor Olaya 2015-06-07 04:33 AM

9495 Feature request Rejected Normal Add new symbol sets 2014-02-04 11:31 PM

9495 Feature request Rejected Normal Add new symbol sets 2014-02-04 11:31 PM

10207 Feature request Rejected Normal Dedicated add North Arrow option in Print Composer 2014-05-07 11:35 PM

10207 Feature request Rejected Normal Dedicated add North Arrow option in Print Composer 2014-05-07 11:35 PM

10251 Feature request Rejected Normal Processing - Order Model saves values Victor Olaya 2014-11-22 02:09 PM

10251 Feature request Rejected Normal Processing - Order Model saves values Victor Olaya 2014-11-22 02:09 PM

10341 Feature request Rejected Low New Plug-in and dependencies. 2014-05-26 02:11 PM
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10341 Feature request Rejected Low New Plug-in and dependencies. 2014-05-26 02:11 PM

10348 Feature request Rejected Normal Let geoprocessing reproject layers before running an analysis 2016-08-23 07:02 AM

10348 Feature request Rejected Normal Let geoprocessing reproject layers before running an analysis 2016-08-23 07:02 AM

10484 Feature request Rejected Normal Italian Cadastral Maps , CXF files and CMF files 2014-06-06 02:08 AM

10484 Feature request Rejected Normal Italian Cadastral Maps , CXF files and CMF files 2014-06-06 02:08 AM

11032 Feature request Rejected Normal Processing: add option for output type (uint8, unit16,..., float, double) in OTB tools Victor Olaya 2017-05-03 07:05 PM

11032 Feature request Rejected Normal Processing: add option for output type (uint8, unit16,..., float, double) in OTB tools Victor Olaya 2017-05-03 07:05 PM

11320 Feature request Rejected Low Not sure if this is the place, just reporting it works on my device 2014-10-04 12:47 AM

11320 Feature request Rejected Low Not sure if this is the place, just reporting it works on my device 2014-10-04 12:47 AM

11364 Feature request Rejected Normal Select All Function > OpenStreetMap plugin - Export OpenStreetMap topology to Spatiallite 2016-05-26 05:22 AM

11364 Feature request Rejected Normal Select All Function > OpenStreetMap plugin - Export OpenStreetMap topology to Spatiallite 2016-05-26 05:22 AM

11803 Feature request Rejected High Plugins and lack of character encoding. 2014-12-07 12:32 PM

11803 Feature request Rejected High Plugins and lack of character encoding. 2014-12-07 12:32 PM

12128 Feature request Rejected Normal modelus: "save as python script" in the context menu Victor Olaya 2015-02-05 03:49 AM

12128 Feature request Rejected Normal modelus: "save as python script" in the context menu Victor Olaya 2015-02-05 03:49 AM

12449 Feature request Rejected Normal Show <description> to OTB commands Victor Olaya 2017-05-01 11:06 AM

12449 Feature request Rejected Normal Show <description> to OTB commands Victor Olaya 2017-05-01 11:06 AM

12720 Feature request Rejected Normal Select -all- OSM topology to spatial Lite 2016-05-26 05:30 AM

12720 Feature request Rejected Normal Select -all- OSM topology to spatial Lite 2016-05-26 05:30 AM

12761 Feature request Rejected Normal More uniform naming of Progessing algs Victor Olaya 2017-04-20 12:22 AM

12761 Feature request Rejected Normal More uniform naming of Progessing algs Victor Olaya 2017-04-20 12:22 AM

12893 Feature request Rejected Normal Keep join field when using processing/qgis 2016-05-23 06:20 AM

12893 Feature request Rejected Normal Keep join field when using processing/qgis 2016-05-23 06:20 AM

13624 Feature request Rejected Low Voting / rating of plugins at plugins.qgis.org 2016-05-24 12:53 PM

13624 Feature request Rejected Low Voting / rating of plugins at plugins.qgis.org 2016-05-24 12:53 PM

14128 Feature request Rejected Normal Allow record editing also from form view 2016-01-18 06:26 AM

14128 Feature request Rejected Normal Allow record editing also from form view 2016-01-18 06:26 AM

14554 Feature request Rejected Normal template for application arguments Alexia 

Mondot

2017-05-03 07:09 PM

14554 Feature request Rejected Normal template for application arguments Alexia 

Mondot

2017-05-03 07:09 PM

14555 Feature request Rejected Normal Multiple choices with only one choice Alexia 

Mondot

2017-05-03 07:10 PM

14555 Feature request Rejected Normal Multiple choices with only one choice Alexia 

Mondot

2017-05-03 07:10 PM

14556 Feature request Rejected Normal RAM parameter Alexia 

Mondot

2017-05-03 07:11 PM

14556 Feature request Rejected Normal RAM parameter Alexia 

Mondot

2017-05-03 07:11 PM

14558 Feature request Rejected Normal unitary tests Alexia 

Mondot

2017-05-03 07:14 PM

14558 Feature request Rejected Normal unitary tests Alexia 

Mondot

2017-05-03 07:14 PM

14771 Feature request Rejected Normal QGIS Browser: being able to sort list of files returned in properties widget of a folder 2016-06-23 09:16 AM

14771 Feature request Rejected Normal QGIS Browser: being able to sort list of files returned in properties widget of a folder 2016-06-23 09:16 AM

15090 Feature request Rejected Normal Make the GDAL/OGR console call editable Victor Olaya 2018-09-12 07:43 PM

15090 Feature request Rejected Normal Make the GDAL/OGR console call editable Victor Olaya 2018-09-12 07:43 PM

15280 Feature request Rejected Low Draw the line in 90 degree or perpendicular 2016-07-14 04:24 AM

15280 Feature request Rejected Low Draw the line in 90 degree or perpendicular 2016-07-14 04:24 AM

15321 Feature request Rejected Normal Allow merge shapefiles from directory Victor Olaya 2016-07-26 05:15 AM

15321 Feature request Rejected Normal Allow merge shapefiles from directory Victor Olaya 2016-07-26 05:15 AM

15326 Feature request Rejected Normal Group geoprocessing tools by type, not source 2016-07-26 05:15 AM

15326 Feature request Rejected Normal Group geoprocessing tools by type, not source 2016-07-26 05:15 AM

16120 Feature request Rejected Normal Statistic panel: Add "Count distinct" to numeric field 2017-09-22 09:54 AM

16120 Feature request Rejected Normal Statistic panel: Add "Count distinct" to numeric field 2017-09-22 09:54 AM

16280 Feature request Rejected Normal Clone a tool in processing modeler Victor Olaya 2017-04-20 12:16 AM

16280 Feature request Rejected Normal Clone a tool in processing modeler Victor Olaya 2017-04-20 12:16 AM

16281 Feature request Rejected Normal Allow unconnected tools in processing models Victor Olaya 2017-04-19 11:51 PM

16281 Feature request Rejected Normal Allow unconnected tools in processing models Victor Olaya 2017-04-19 11:51 PM

16288 Feature request Rejected Normal Expose attributes in processing modeler Victor Olaya 2018-05-16 02:18 PM

16288 Feature request Rejected Normal Expose attributes in processing modeler Victor Olaya 2018-05-16 02:18 PM

16804 Feature request Rejected Normal EXP DIALOG AND (RANDOM) COLOUR_RGB 2017-07-10 12:13 PM

16804 Feature request Rejected Normal EXP DIALOG AND (RANDOM) COLOUR_RGB 2017-07-10 12:13 PM

17838 Feature request Rejected Normal Add Orfeo ToolBox (OTB) plugins support for version > 5.8.0 2018-01-15 08:17 AM

17838 Feature request Rejected Normal Add Orfeo ToolBox (OTB) plugins support for version > 5.8.0 2018-01-15 08:17 AM

18129 Feature request Rejected Normal Processing > Toolbox > GDAL - where fixed layer names are used have a option to use the filename 2018-05-16 01:27 PM

18129 Feature request Rejected Normal Processing > Toolbox > GDAL - where fixed layer names are used have a option to use the filename 2018-05-16 01:27 PM

19757 Feature request Rejected Normal Add ChangeDataSource in QGIS 3.x 2018-09-04 08:49 AM

19757 Feature request Rejected Normal Add ChangeDataSource in QGIS 3.x 2018-09-04 08:49 AM

19943 Feature request Rejected Normal Extend algorithm only extends, but does not shorten lines 2018-09-25 11:22 PM

19943 Feature request Rejected Normal Extend algorithm only extends, but does not shorten lines 2018-09-25 11:22 PM

20028 Feature request Rejected Normal  request profile information (qProf 0.4.2) 2018-10-05 04:51 PM

20028 Feature request Rejected Normal  request profile information (qProf 0.4.2) 2018-10-05 04:51 PM

20903 Feature request Rejected Normal Plugins for 3.4.2 for QGIS Jürgen 

Fischer

2019-01-02 09:05 AM

20903 Feature request Rejected Normal Plugins for 3.4.2 for QGIS Jürgen 

Fischer

2019-01-02 09:05 AM

21005 Feature request Rejected High How to create point along road centre line with offset value Alexandre 

Neto

2019-01-15 05:12 PM

21005 Feature request Rejected High How to create point along road centre line with offset value Alexandre 

Neto

2019-01-15 05:12 PM
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